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ВВЕДЕНИЕ 
 
Системы автоматизированного проектирования, в частно-

сти Pro/ENGINEER, SolidWorks, предоставляют конструкто-
рам и программистам обширные возможности проектировать 
3D-геометрию параметрических компьютерных моделей де-
талей и узлов машиностроения. Это наиболее признанные во 
всем мире системы компьютерного моделирования, использо-
вание которых значительно сокращает сроки разработки кон-
структорской документации и технологической подготовки 
производства.  

Этому в значительной мере способствуют адаптация этих 
систем под логику инженера-механика, функциональность,  
а также инструменты разработки пользовательских приложе-
ний и специальных настроек. 

Наряду с системой AutoCAD система SolidWorks обладает 
широкими возможностями, в частности средствами автомати-
зации создания 3D-моделей деталей и сборок, которые сложно 
представить в рамках этого небольшого издания. Поэтому ос-
новное внимание сосредоточено на описании приемов, с по-
мощью которых можно выполнить трехмерное моделирова-
ние деталей различной степени сложности. В программном 
обеспечении SolidWorks имеется учебное пособие, позволяю-
щее самостоятельно подробно, пошагово осваивать основные 
приемы моделирования деталей и сборок. 
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Лабораторная работа № 1 
 

СИСТЕМА PRO/ENGINEER. ОБЩИЕ СВЕДЕНИЯ. 
ОСОБЕННОСТИ УСТАНОВКИ СИСТЕМЫ 

 
Цель работы: ознакомиться с основными особенностями 

системы Pro/ENGINEER и получить навыки установки и ад-
министрирования данного пакета. 

 
Общие сведения 

 
Обзор основных средств объектной модели САПР 

Pro/ENGINEER 
Проектирование в САПР Pro/ENGINEER – это процесс со-

здания электронной модели изделия в данном случае сред-
ствами САПР Pro/ENGINEER. 

Система Pro/ENGINEER предоставляет разработчикам сле-
дующие преимущества в процессе разработки: 

– наглядность проектируемой модели, что позволяет избе-
жать ошибок, связанных с представлением сложной трехмер-
ной геометрии по проекционным чертежам; 

– оперирование геометрией на уровне объектов инженер-
ных элементов, что в значительной мере упрощает и ускоряет 
процесс проектирования.  

Pro/ENGINEER – мощная система твердотельного модели-
рования, используемая для создания 3D-моделей деталей и сбо-
рок. В процессе проектирования деталей могут быть задей-
ствованы также и другие модули Pro/ENGINEER, например 
чертежный модуль, модуль маршрутизации проводки, модуль 
листового железа, технологические модули и т. д. 

Основными отличительными особенностями системы яв-
ляются: 

• твердотельное (Solid) моделирование; 
• геометрия, базированная на фичерах (конструктивных эле-

ментах); 
• параметризация; 
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• отношение Родитель/Потомок; 
• ассоциативность; 
• модель, как основное средство передачи конструкторской 

информации. 
Система может создавать модели с различным типом гео-

метрии – твердотельной, поверхностной, комбинированной. 
Геометрия модели состоит из блоков, из которых строится  
в последующем деталь. Каждый такой «кирпичик» носит на-
звание фичер. Это справедливо как для деталей, так и для сбо-
рок, состоящих в том числе и из деталей. 

 

Процесс установки Pro/ENGINEER 
Процесс установки Pro/ENGINEER состоит из следующего 

порядка шагов:  
1. Установка PTC License Server. 
2. Установка Pro/ENGINEER.  
3. Установка Structural and Thermal Simulation. 
4. Интеграция Structural and Thermal Simulation в 

Pro/ENGINEER.  
5. Установка Pro/STDS и создание ярлыка запуска 

Pro/ENGINEER. 
 

Требования к рабочим станциям  
Рабочая станция (компьютер) инженера должна соответст-

вовать следующим минимальным требованиям. 
Операционная система (ОС) – Windows 2000, Windows XP SP2.  
Дисковое пространство:  
– минимум 2 раздела: C:\ и D:\, файловая система – NTFS; 
– C:\ – ОС, пользовательское ПО. Размер: минимум 20 Gb; 
– D:\ – Pro/ENGINEER и рабочая информация. Размер: все 

оставшееся пространство.  
Файл подкачки на диске С:\ – фиксированного размера  

и равен двухкратному объему оперативной памяти.   
Возможны два вида установки программы PTC LicenseServer: 
а) на каждую рабочую станцию;   
б) на один компьютер в сети – сервер лицензий.  
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Мы рассматриваем случай установки сервера лицензий на 
каждую рабочую станцию.  

Если предполагается использовать сервер лицензий, уста-
новленный на другом компьютере в сети, установку PTC 
LicenseServer производить не нужно – шаг 1 пропускается.  

Также не обязателен шаг 3 и 4, если на данном рабочем ме-
сте не предполагается заниматься инженерными расчетами 
механических и физических характеристик моделей. 

PTC LicenseServer – сервер лицензий – разрешает или за-
прещает работу Pro/Engineer и его компонентов в соответст-
вии с имеющимися у вас лицензиями для одного или группы 
пользователей.  

Pro/Engineer – основная программа.  
StructuralandThermal – модуль для расчета механической 

прочности, теплового состояния и Simulation термопрочности 
моделей. 

PRO/STDS – пакет дополнительных настроек Pro/ENGINEER. 
Позволяет адаптировать систему к стандартам ЕСКД, русифи-
цировать интерфейс; содержит библиотеки стандартных изде-
лий, шаблоны деталей, чертежей и др. 

 
Задание к лабораторной работе 

 
В соответствии с указаниями преподавателя и инструкция-

ми, расположенными в файле ProE_инструкция.pdf, осущест-
вите установку системы на диск D вашего компьютера и озна-
комьтесь с основным интерфейсом САПР Pro/ENGINEER. 

 
Содержание отчета 

 
1. Титульный лист. 
2. Цель работы с учетом выполненного задания. 
3. Алгоритм установки. 
4. Установленная конфигурация системы. 
5. Вывод. 
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Лабораторная работа № 2 
 

ОСНОВНЫЕ ПРИЕМЫ РАБОТЫ И УПРАВЛЕНИЯ  
В СИСТЕМЕ PRO/ENGINEER 

 
Цель работы: описать концепцию проектирования 

Pro/ENGINEER, получить навыки по управлению основным 
интерфейсом Pro/ENGINEER Wildfire, осуществлению пред-
варительного просмотра, загрузки и управления ориентацией 
модели, управления оперативной памятью компьютера и ди-
ректориями при работе с Pro/ENGINEERWildfire. 

 
Общие сведения 

 
Основная концепция Pro/ENGINEERWildfire 
 

 
 

Рис. 2.1. Основная концепция Pro/ENGINEER 
 
Pro/ENGINEER Wildfire – мощная система твердотельного 

моделирования, используемая для создания 3D-моделей дета-
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лей и сборок. В процессе проектирования деталей могут быть 
задействованы также и другие модули Pro/ENGINEER, напри-
мер чертежный модуль, модуль маршрутизации проводки, 
модуль листового железа, технологические модули и т. д.   

 
Твердотельное моделирование  
Твердотельное моделирование (рис. 2.2) позволяет визуа-

лизировать идеи в трехмерном пространстве, создавая реали-
стические представления деталей и сборок. Дополнительно 
модель содержит свойства, такие как масса, объем, центр тя-
жести, площадь поверхностей и т. д. После добавления или 
удаления фичеров свойства модели сразу обновятся.  

 

 
 

Рис. 2.2. Твердотельное моделирование 
 
Например, если Вы добавите в модель отверстие, масса мо-

дели уменьшится.  
Твердотельные модели позволяют проводить анализ допус-

ков и интерференций/зазоров в сборке. 



10 

Геометрия, базированная на конструктивных элементах 
Модели Pro/ENGINEER – это набор фичеров, каждый вновь 

создаваемый фичер опирается на фичер, созданный ранее, как 
кирпичи в здании. Индивидуально каждый фичер – это про-
стой элемент, однако вместе они могут образовывать очень 
сложные по форме детали и сборки. В качестве примера рас-
смотрите шесть этапов создания шатуна:  

• создание первого твердотельного выдавливания, форми-
рующего основные габаритные размеры и форму детали; 

• дополнительное выдавливание, созданное вверху модели, 
формирует посадочное место под поршневой палец; 

• дополнительное выдавливание, созданное внизу модели, 
формирует посадочное место под шатунную шейку; 

• верхнее отверстие, формирует посадочное отверстие под 
поршневой палец; 

• нижнее отверстие, формирует посадочное отверстие под 
шатунную шейку; 

• скругление четырех внутренних кромок. 
 
Параметризация  
В Pro/ENGINEER геометрия модели управляется размерами 

и параметрами. Это выражается в том, что изменение значения 
размера или параметра приведет к обновлению геометрии. 

 
Отношение Родитель/Потомок  
Отношение Родитель/Потомок позволяет увязывать воедино 

все фичеры (конструктивные элементы) детали. В процессе про-
ектирования модели в Pro/ENGINEER эти отношения между 
фичерами создаются постоянно. В сборке это справедливо и для 
компонентов. Для использования всех преимуществ отношения 
Родитель/Потомок Вы должны правильно им управлять. При 
создании нового фичера, фичеры, на которые ссылается созда-
ваемый объект, становятся его Родителями. Далее это выража-
ется в том, что изменение родительского фичера повлечет за 
собой изменения объектов, ссылающихся на данный фичер.  
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На слайде, в качестве примера, показана модель поршня  
с отверстием. Модель слева – это исходное состояние поршня. 
На среднем рисунке высота поршня изменилась с 18.5 до 25.  

Обратите внимание, отверстие поршня переместилось вверх, 
сохраняя первоначальное расстояние между своим центром  
и верхней поверхностью. Такое поведение объясняется нали-
чием между отверстием и верхней поверхностью поршня от-
ношения Родитель/Потомок, так как при создании отверстия 
его центр был образмерен относительно верхней поверхности 
поршня. Соответственно полученный размер является посто-
янным и независящим от высоты поршня.  

В качестве альтернативы мы можем образмерить центр  
отверстия относительно нижней поверхности поршня, тогда 
отверстие поведет себя по-другому. Правый рисунок показы-
вает изменение двух размеров поршня: его высоты и диаметра 
отверстия. 

 
Ассоциативность & Модель, как основное средство  

передачи конструкторской информации  
В Pro/ENGINEER основным источником конструкторской 

информации является модель. Например, если изменится мо-
дель детали, автоматически изменится ее чертеж и сборка, в ко-
торую входит эта деталь. Эта ассоциативность двунаправлен-
ная, это означает, что изменение чертежа модели приведет  
к изменению самой модели в 3D и отразится на ее отображе-
нии в других режимах (сборка, технология и т. д). Как только 
модель создана, на ее основе можно быстро создать все необ-
ходимые чертежные виды с разрезами и сечениями. Размеры 
на чертеже могут быть также взяты из 3D-модели.  

Дополнительно компоненты (детали или подсборки) могут 
формировать сборочную модель. В зависимости от типа сборки 
детали в ней могут быть статическими (жестко зафиксирован-
ными) или динамическими (формируя подвижный механизм). 
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Рис. 2.3. Ассоциативность модели 
 

Задание к лабораторной работе 
 
Для просмотра модели в окне Pro/ENGINNER проделайте 

следующие действия:  
1. Запустите Pro/ENGINEER Wildfire.  
2. В навигаторе откройте закладку Connections (Соедине-

ния) и просмотрите ее содержимое.  
3. В навигаторе откройте закладку FolderBrowser (навига-

тор папок). В навигаторе папок переместитесь в папку c:\Обу-
чение_PROE\БАЗОВЫЙ_КУРС_WF3\УЧЕБНЫЕ_МОДЕЛИ\ 
module_01.  
Открывшийся браузер покажет содержимое папки.  
4. В навигаторе выделите папку module_01, нажмите  

правую клавишу мыши и в выпадающем меню выберите 
SetWorkingDirectory (Задать рабочую папку). 

Для всех манипуляций с моделью, связанных с ее враще-
нием/панорамированием/масштабированием, нам понадобит-
ся средняя клавиша мыши.  
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Для вращения модели относительно центра вращения 
(spincenter) нажмите среднюю клавишу и перемещайте мышь 
в любую сторону. 

Для панорамирования модели нажмите SHIFT+среднюю 
клавишу мыши и также переместите мышь.  

Для масштабирования модели нажмите CTRL+среднюю кла-
вишу мыши и переместите мышь вверх или вниз. Если у Вас 
на мышке есть колесо, то, вращая его, также сможете масшта-
бировать модель.  

В дополнение к описанным способам, Вы можете переме-
щать модель на экране с помощью расширенных методов ви-
зуализации (режим ViewMode (режим Ориентации)). 

Вы можете ускорить вращение модели, если отключите ее 
прозрачность: View > DisplaySettings > ModelDisplay (Вид > 
Установки показа > Показ модели). В появившемся диалого-
вом окне раскройте закладку Shade (Закраска) и отмените вы-
бор прозрачности, для чего уберите галочку из ячейки 
Transparency (Прозрачность). Затем нажмите OK. 

 
Содержание отчета 

 
1. Титульный лист. 
2. Цель работы с учетом выполненного задания. 
3. Скриншеты экрана панорамирования модели. 
4. Вывод. 
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Лабораторная работа № 3 
 

СОЗДАНИЕ НОВОЙ МОДЕЛИ В PRO/ENGINNER 
И ЗНАКОМСТВО С ЕЕ ЭСКИЗОМ 

 
Цель работы: научиться создавать новые модели, исполь-

зуя заданные по умолчанию шаблоны, создавать и редактиро-
вать внешний эскиз, понимать принцип создания трехмерной 
геометрии с помощью базовых инструментов, таких как 
Extrude (Выдавливание), Revolve (Вращение) и Rib (Ребра), по-
нимать, как создание ссылочной геометрии с использованием 
эскиза влияет на отношение Родитель/Потомок, научиться 
создавать конструктивные элементы по эскизам конструктив-
ных элементов. 

 
Общие сведения 

 
Создание модели в Pro/Engineer 
Заданные по умолчанию шаблоны – начальная стадия со-

здания модели детали или сборки. Шаблоны содержат в себе 
общие для всех деталей элементы, такие как опорные плоско-
сти, набор слоев, сохраненные виды, параметры, единицы из-
мерения и т. д. Шаблоны, заданные по умолчанию, применя-
ются, когда Вы создаете новую деталь или сборку.  

Используя шаблон в дальнейшем можно избежать многих 
проблем, связанных с соответствием детали корпоративным 
стандартам. Стандартный шаблон позволит всем инженерам 
предприятия создавать модели от общей «отправной точки»,  
и гарантирует в каждой модели, созданной на предприятии, 
наличие всех требуемых параметров.  

Например, стандарт предприятия предписывает наличие в 
каждой модели параметра «РАЗРАБОТАЛ» для определения 
первичного разработчика. Вы вносите в общий шаблон этот 
параметр, и все, вновь создаваемые детали на предприятии, 
будут иметь обязательный параметр «РАЗРАБОТАЛ». 
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В основе всех трехмерных фигур, показанных на слайде, 
лежит плоский эскиз. Ниже приведен примерный порядок со-
здания эскиза. 

 

 
 

Рис. 3.1. Создание эскиза 
 

На рис. 3.2 приведены освновные инструменты эскиза. 
 

 
 

Рис. 3.2. Основные элементы эскиза 
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Наложение геометрических ограничений (рис. 3.3) на эскиз 
является очень важным моментом при его создании. Наложе-
ние ограничений добавляет Вашему эскизу логики и делает 
изменения эскиза более предсказуемыми. Также с помощью 
геометрических ограничений Вы уменьшаете количество не-
обходимых размеров для описания геометрии. Например, Вы 
можете создать эскиз, который будет симметричен относи-
тельно центральной линии, как показано на рисунке, можете 
назначить линии горизонтальность или вертикальность. Вы 
можете назначить линиям или дугам равенство длин или ра-
венство радиусов соответственно. Следующая таблица пред-
ставляет список геометрических ограничений, доступных по-
сле нажатия на панели эскиза иконки. 

 
 

 
 
 

Рис. 3.3. Ограничения модели 
 
 
Создание геометрии по эскизу 
Концепцию создания геометрии по эскизу отражает рис. 3.4. 
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Рис. 3.4. Этапы создания геометрии по эскизу 
 
Процесс создания твердотельного объекта с помощью эс-

киза состоит в выборе или создании эскиза и выдавливании 
этого эскиза в пространство по определенному закону. 

В основе фичера Extrude (Выдавливание) лежит плоский 
эскиз, который выдавливается в пространство на определен-
ную глубину по направлению, перпендикулярному плоскости 
эскизирования. С помощью этого инструмента можно созда-
вать сплошное добавление материала или сплошной вырез, 
тонкостенное добавление материала или тонкостенный вырез, 
выдавливание как поверхность или обрезка поверхности. 

Опция Утолщение эскиза доступна для нескольких типов 
эскизных фичеров. После создания эскиза с закрытым или от-
крытым сечением, Вы можете выдавить его на определенную 
глубину или повернуть относительно оси на определенный 
градус, плюс задать толщину эскиза и направление, в котором 
эта толщина будет добавляться. Открытое сечение показано 
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на верхнем рисунке слайда. После создания эскиза выдавли-
ваете его в пространство и задаете ему толщину.  

В основе фичера Revolve (Вращение) лежит плоский эскиз, 
который поворачивается на определенный угол относительно 
собственной или специально указанной оси вращения. С по-
мощью этого инструмента можно создавать сплошное добав-
ление материала или сплошной вырез, тонкостенное добавле-
ние материала или тонкостенный вырез, выдавливание как 
поверхности или обрезка поверхности.  

Толщина может быть добавлена на любую из двух сторон, 
плюс симметрично в обе стороны. Другим примером может 
послужить создание трубы, когда эскиз в виде окружности 
выдавливается в пространство на определенную глубину и  
с определенной толщиной стенки.  

Ребра обычно используются для усиления деталей. Закон, 
по которому эскиз выдавливается в пространство, похож на 
Выдавливание, за исключением того, что сечение для данного 
объекта должно быть всегда открытым. Ниже приведены ри-
сунки для иллюстрации основного отличия инструмента Реб-
ро от Прямого выдавливания. 

 

 
 

Рис. 3.5. Фичеры Выдавливание и Ребра 
 
После выбора или создания открытого сечения и ввода 

толщины ребра, система создаст ребро, слитое с общим объе-
мом модели. Система может добавлять материал выше или 
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ниже сечения, и ребро может быть выдавлено в любую из сто-
рон относительно эскизной плоскости, плюс симметрично  
в обе стороны. На верхних рисунках слайда показаны приме-
ры, в которых материал может быть добавлен только вниз. 
Однако если и с той и с другой стороны эскиза система смо-
жет образовать замкнутый контур, ребро можно будет создать 
в любую сторону. 

 
Задание к лабораторной работе 

 
Создание эскиза 
1. Если Pro/ENGINEER открыт, закройте все окна и очи-

стите сессию. Щелкните File > Close Window (Файл > Закрыть 
окно), затем File > Erase > Not Displayed > OK. Если 
Pro/ENGINEER закрыт, запустите его.  

2. В навигаторе откройте закладку FolderBrowser. В нави-
гаторе папок переместитесь в папку c:\Обучение_PROE\БАЗО-
ВЫЙ_КУРС_WF3\УЧЕБНЫЕ_МОДЕЛИ\module_02. Открыв-
шийся браузер покажет содержимое папки.  

3. В навигаторе выделите папку module_02, нажмите пра-
вую клавишу мыши и в выпадающем меню выберите 
SetWorkingDirectory.  

4. Создайте новую модель с использованием шаблона, 
предложенного по умолчанию:  

• щелкните File > New > Part или на главной панели инст-
рументов нажмите иконку New (Новый) > Part (Деталь); 

• название модели задайте NOVAYA_DETAL, затем нажми-
те ОK.  

5. Если опорные плоскости и система координат в детали не 
показаны, на главной панели инструментов включите их отоб-
ражение с помощью иконок, соответственно DatumPlaneson/off 
(Базовые плоскости вкл/выкл) и CoordinateSystemson/off 
(вкл/выкл системы координат).  

6. Выберите каждый объект в дереве моделей для подсвет-
ки его в рабочем окне.  
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7. В дереве слоев просмотрите слои, созданные по умол-
чанию: 

• для переключения на дерево слоев на главной панели на-
жмите иконку LayerTree (Дерево слоев); 

• в дереве слоев выберите слой 01___PRT_ALL_DTM_PLN, 
нажмите правую клавишу мыши и в выпадающем меню выбе-
рите LayerProperties (Свойства слоев). В окне LayerProperties 
(Свойства слоя) посмотрите на содержимое слоя. Раскройте 
закладку Rules (Правила), обратите внимание, данный слой 
имеет правила, благодаря которым все опорные плоскости за-
носятся на этот слой автоматически. В окне LayerProperties 
(Свойства слоя) нажмите Close (Отмена);  

• для переключения на дерево моделей на главной панели 
отожмите иконку LayerTree (Дерево слоев).  

8. Просмотрите единицы измерения модели (units): 
• в главном меню щелкните Edit > Setup > Units (Править > 

Настройка > Единицы). В диалоговом окне UnitManager (Ме-
неджер единиц измерения) обратите внимание на активную 
систему единиц измерения; 

• в окне UnitManager (Менеджер единиц измерения) на-
жмите Close (Закрыть). 

9. Далее мы проверим созданные по умолчанию параметры: 
• щелкните Tools > Parameters (Инструменты > Параметры); 
• в диалоговом окне Parameters (Параметры) введите Вашу 

фамилию в качестве значения параметра «РАЗРАБОТАЛ»; 
• нажмите ОK и параметру «РАЗРАБОТАЛ» будет присво-

ено новое значение.  
10. На главной панели инструментов нажмите Save (Сохра-

нить) > ENTER.  
11. Щелкните File > Erase > Not Displayed > OK (Файл > 

Стереть > Невидимые).  
 
Редактирование эскиза 
1. Если Pro/ENGINEER открыт, закройте все окна и очи-

стите сессию: 



21 

• щелкните File > CloseWindow (Файл > Закрыть окно), за-
тем File > Erase > NotDisplayed > OK (Файл > Стереть > Неви-
димые).  

Если Pro/ENGINEER закрыт, запустите его.  
2. В навигаторе откройте закладку FolderBrowser. В навига-

торе папок переместитесь в папку c:\Обучение_PROE\БАЗО-
ВЫЙ_КУРС_WF3\УЧЕБНЫЕ_МОДЕЛИ\module_02.  

Открывшийся браузер покажет содержимое папки.  
3. В навигаторе выделите папку module_02, нажмите пра-

вую клавишу мыши и в выпадающем меню выберите 
SetWorkingDirectory.  

4. Создайте новую модель с использованием шаблона, пред-
ложенного по умолчанию: 

• щелкните File > New > Part (Файл > Новый > Деталь) или 
на главной панели инструментов нажмите иконку New (Но-
вый) > Part (Деталь); 

• название модели задайте NOVAYA_DETAL, затем на-
жмите OK; 

• оставьте без изменения выбранный шаблон и щелкните OK; 
• новый файл с названием NOVAYA_DETAL будет создан.  
5. Если опорные плоскости и система координат в детали не 

показаны, на главной панели инструментов включите их отоб-
ражение с помощью иконок, соответственно DatumPlaneson/off 
(Базовые плоскости вкл/выкл) и CoordinateSystemson/off 
(вкл/выкл системы координат).  

 
Открытие детали Коленчатый вал и создание ее эскиза 
Необходимо создать коленчатый вал дрели, опираясь на 

геометрию, которая была создана ранее, плюс Вам будет 
необходимо создать несколько опорных фичеров для гарантии 
собираемости деталей в будущем. 
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Рис. 3.6. Коленчатый вал дрели 
 
1. Если Pro/ENGINEER открыт, закройте все окна и очи-

стите сессию: 
• щелкните File > CloseWindow (Файл > Закрыть окно), за-

тем File > Erase > NotDisplayed > OK (Файл > Стереть > Неви-
димые).  

2. В навигаторе откройте закладку FolderBrowser (Навигатор 
папок). В навигаторе папок переместитесь в папку c:\Обу-
чение_PROE\БАЗОВЫЙ_КУРС_WF3\УЧЕБНЫЕ_МОДЕЛИ\ 
module_03. 

3. В навигаторе выделите папку module_03, нажмите пра-
вую клавишу мыши и в выпадающем меню выберите 
SetWorkingDirectory (Задать рабочую папку).  

4. В браузере дважды щелкните по детали CRANKSHAFT.PRT 
(Коленвал).   

5. Если опорные плоскости и оси в детали не показаны, на 
главной панели инструментов включите их отображение с по-
мощью иконок, соответственно DatumPlaneson/off (Базовые 
плоскости вкл/выкл) и DatumAxison/off (Базовые оси вкл/выкл). 

6. На главной панели нажмите иконку SketchTool (Рисова-
ние). В качестве эскизной плоскости укажите опорную плос-
кость FRONT (в дереве моделей или непосредственно на мо-
дели). В диалоговом окне Sketch (Эскиз) нажмите Sketch (Эс-
киз). После чего необходимо войти в режим создания эскиза. 
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7. Оставьте выбранные базы без изменений и в диалоговом 
окне Reference (Привязки), нажмите OK. 

8. Для отключения отображения опорных плоскостей на 
главной панели отожмите иконку DatumPlaneson/off (Базовые 
плоскости вкл/выкл).  

9. На панели эскиза выберите иконку Circle (Окружность). 
Нарисуйте окружность и образмерьте ее, как показано на левой 
части рис. 3.7. Для завершения создания эскиза на панели эски-
за нажмите иконку CompleteSketch (Продолжить с текущим се-
чением). Готовый эскиз показан на правой части рис. 3.7. 

 

 
 

Рис. 3.7. Эскиз коленчатого вала 
 
Для отключения отображения опорных осей на главной па-

нели отожмите иконку DatumAxison/off (Базовые оси вкл/выкл). 
Для отмены выбора всех элементов просто щелкните по пус-
тому месту графического окна.  

10. На главной панели инструментов нажмите иконку 
SavedViewList (Список сохраненных видов) и в выпадающем 
списке выберите StandardOrientation.  

11. На панели создания фичеров нажмите иконку ExtrudeTool 
(Выдавливание). Далее в дереве моделей выберите эскиз 
CRANK_DIA. Система покажет предварительный просмотр 
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создаваемого тела. По умолчанию система создает выдавли-
вание в одну сторону.  

12. Для создания выдавливания и в другую сторону на диа-
логовой панели создания выдавливания раскройте панель 
Options (Опции) и установите глубину для второй стороны как 
Blind (Глубина).  

13. Курсором перемещайте маркеры глубины, затем в гра-
фическом окне введите окончательные значения 46.5 и 73.5, 
как показано на рис. 3.8. 

 

 
 

Рис. 3.8. Создание коренной шейки вала дрели 
 
Для завершения создания фичера на диалоговой панели 

нажмите иконку Complete Feature (Принять и сохранить). 
На главной панели инструментов включите отображение 

опорных плоскостей с помощью иконки DatumPlaneson/off 
(Базовые плоскости вкл/выкл).  

На панели создания фичеров нажмите иконку ExtrudeTool 
(Выдавливание). Далее в дереве моделей выберите эскиз LOBE. 
Система покажет предварительный просмотр создаваемого 
тела. По умолчанию система создает выдавливание в одну 
сторону. Для создания выдавливания и в другую сторону, на 
диалоговой панели создания выдавливания раскройте панель 
Options (Опции) и установите глубину для обеих сторон как 
ToSelected (До выбранной). В качестве ссылок укажите плос-
кости LOBE_FRONT и LOBE_REAR (рис. 3.9). 
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Рис. 3.9. Создание базового кулачка 
 
Для завершения создания фичера на диалоговой панели 

нажмите иконку Complete Feature (Принять и сохранить). 
На панели создания фичеров нажмите иконку ExtrudeTool 

Выдавливание). Далее в дереве моделей выберите эскиз 
PIN_DIA. На диалоговой панели создания выдавливания рас-
кройте список опций задания глубины и установите выдавлива-
ние в обе стороны (рис. 3.10). Глубину выдавливания задайте 10. 

 

 
 

Рис. 3.10. Опция задания глубины 
 
Для переключения на создание выреза на диалоговой пане-

ли нажмите иконку.  
Иконкой установите стрелку направления удаления мате-

риала наружу от PIN_DIA, как показано на левой части  
рис. 3.11.  
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Рис. 3.11. Создание выреза 
 
Для завершения создания фичера на диалоговой панели на-

жмите иконку Complete Feature (Принять и сохранить). 
Готовый вырез показан на правой части рис. 3.12. 
 

 
 

Рис. 3.12. Готовая модель коленчатого вала дрели 
 

Содержание отчета 
 
1. Титульный лист. 
2. Цель работы. 
3. Скриншеты полученной модели. 
4. Выводы. 
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Лабораторная работа № 4 
 

ОСНОВНЫЕ ПРИЕМЫ МОДЕЛИРОВАНИЯ ПРОСТЫХ 
ДЕТАЛЕЙ В СИСТЕМЕ SOLIDWORKS 2009 

 
Цель работы: освоить основные приемы трехмерного (3D) 

проектирования твердотельных простых деталей на примере си-
стемы автоматизированного проектирования SolidWorks 2009. 

 
Основные положения 

 
Программа SolidWorks 2009 представляет интегрирован-

ную среду трехмерного автоматизированного проектирования 
как простых, так и сложных деталей и конструкций, исполь-
зующая графический интерфейс MicrosoftWindows. Она предо-
ставляет полный цикл моделирования: проектирование трех-
мерных деталей, сборка из отдельных деталей, сборочные чер-
тежи и деталировки, а также представление моделей в реалис-
тичном (визуализация) и динамичном (анимация) видах. 

Процесс моделирования в SolidWorks начинается с создания 
эскиза, то есть двухмерного профиля или поперечного сечения. 
Затем эскиз при помощи определенного конструктивного эле-
мента (бобышки, выреза, отверстия, скругления, фаски, обо-
лочки и т. д.) приобретает трехмерный вид. Эскизы могут быть 
вытянуты, повернуты, рассечены сложным образом или сме-
щены по контуру. Набор эскизов и конструктивных элементов 
образует деталь. Затем детали компонуются в сборку с помо-
щью их взаимного расположения и сопряжения. После провер-
ки работоспособности сборки на ее основе создается сбороч-
ный чертеж и чертежи входящих в сборку отдельных деталей.  

Таким образом, в процессе моделирования создается не де-
таль, например, модель по трем проекциям (САПР AutoCAD),  
а алгоритм (последовательность операций) ее создания. Зада-
ются размеры и геометрические взаимосвязи между элемента-
ми. Размеры, взаимосвязи и уравнения определяют форму кон-
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кретной детали. При изменении размеров изменяются форма  
и размеры детали, но сохраняется общий замысел проекта. 

 
Преимуществами САПР SolidWorks являются: 
– технология SWIFT (SolidWorksIntelligentFeatureTechnology), 

которая представляет собой автоматизированную систему ана-
лиза ошибок и проблем, которые могут возникнуть после фик-
сации на данном этапе своего решения проектировщиком при 
дальнейшем проектировании детали и сборки. «Умная» техно-
логия SWIFT предлагает конструктору исправить все выявлен-
ные на текущем этапе проектирования ошибки и проблемы; 

– адаптированный (head-up) пользовательский интерфейс 
объединяет одинаковые функции управления проектом в об-
щие группы утилиты CommandManager, что упрощает проек-
тировщику доступ к функциям работы с проектом и суще-
ственно сокращает время разработки сложных объектов; 

– широкие возможности коллективной работы с докумен-
тами и интерактивная поддержка пользователей; 

– интеграция SolidWorks с другими САПР. 
 
Главное окно SolidWorks 
Главное окно (рис. 4.1) системы автоматизированного про-

ектирования SolidWorks включает в себя следующие элемен-
ты: главное меню, панели инструментов, рабочую область, 
интерактивную помощь, строку состояния. 

Главное меню SolidWorks 2009 находится под строкой за-
головка. Оно содержит пункты, доступные в настоящий мо-
мент. В зависимости от типа активного документа (деталь, 
сборка или чертеж) набор пунктов главного меню изменяется. 
Если не открыт ни один из документов, главное меню содер-
жит четыре пункта: File (Файл), View (Вид), Tools (Инстру-
менты) и Help (Справка). При наличии активного документа  
в главном меню добавляются следующие пункты: Edit (Прав-
ка), Insert (Вставка) и Window (Окно). Если активное окно до-
кумента распахнуто на весь экран, левее пункта меню File 
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(Файл) появляется значок, соответствующий типу активного 
документа:  детали,  сборки или  чертежа. Если 
размер окна активного документа меньше рабочей области, 
значок расположен в заголовке соответствующего окна. 

 

 
 

Рис. 4.1. Главное окно SolidWorks 
 
Рабочая область занимает все свободное пространство между 

панелью инструментов и строкой состояний. При отсутствии ак-
тивных документов она пустая. Обычно рабочая область разде-
лена на две части: диспетчерскую (слева) и графическую (спра-
ва). В дальнейшем эти области будут рассмотрены подробнее. 

Строка состояний расположена в нижней части главного 
окна программы SolidWorks 2009. Содержание строки состоя-
ний зависит от типа активного документа и отображает такую 
информацию: 

– имя активного документа или краткое описание того пункта 
меню или конструктивного элемента, на котором в данный 
момент находится курсор мыши; 
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– текущие координаты расположения курсора; 
– состояние эскиза: OverDefined (Переопределен), Under 

Defined (Определен не полностью) или FullyDefined (Полно-
стью определен); 

– текст «EditingSketch/Part/Assembly/Drawing» («Редактиро-
вание эскиза/детали/сборки/чертежа»). 

Панели инструментов. В SolidWorks насчитывается 278 па-
нелей инструментов (рис. 4.2), не считая панели инструментов 
дополнительных модулей. Панели инструментов предназначены 
для ускорения работы в различных режимах. Панель инструмен-
тов Standard (Стандартная) в минимальной конфигурации появ-
ляется при первом запуске программы. В зависимости от вида 
выполняемой работы (создания детали, сборки или чертежа) 
отображаются различные панели инструментов. Панели инстру-
ментов могут располагаться как по периметру рабочей области 
(прикрепленные панели), так и в любом месте на рабочей обла-
сти (плавающие панели). С помощью технологии drag&drop 
панели инструментов можно перемещать по рабочей области, 
расставляя их в соответствии со своими требованиями. 

 

 
 

Рис. 4.2. Включение установленных приложений 
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Основные функции работы с системой расположены на стан-
дартной панели инструментов Стандартная. При необходи-
мости включения той или иной установленной ранее надст-
ройки (SolidWorksMotion, CosmosFlowWorks) нужно выбрать 
на кнопке Настройка панели Стандартная пункт меню При-
ложения и в появившемся окне (рис. 4.2) выбрать ранее уста-
новленное требуемое приложение. 

 
Основные понятия и определения 
В моделях SolidWorks используются следующие термины. 
Origin (Исходная точка) – отображается в виде двух стре-

лок серого цвета и представляет (0,0,0) координату модели. 
Когда эскиз становится активным, исходная точка эскиза ото-
бражается красным цветом и представляет (0,0,0) координату 
эскиза. Размеры и взаимосвязи могут быть добавлены к ис-
ходной точке модели, но не эскиза. 

Axis (Ось) – прямая линия, которая используется для созда-
ния геометрии модели, элементов или шаблонов. Ось можно 
создать различными способами, включая пересечение двух 
плоскостей. 

Plane (Плоскость) – плоская вспомогательная геометрия. 
Можно использовать плоскости для добавления двухмерного 
эскиза, для разреза модели, а также в качестве нейтральной 
плоскости для уклона и т. д. 

Face (Грань) – границы, которые позволяют определить 
форму модели или поверхности. Грань − это область модели 
или поверхности, которую можно выбрать. Например, прямо-
угольная твердотельная деталь имеет шесть граней. 

Vertex (Вершина) – точка, в которой пересекаются две или не-
сколько линий или кромок. Вершины можно выбрать для созда-
ния эскизов, нанесения размеров и множества других операций. 

Edge (Кромка) – место, в котором две грани или поверхно-
сти соприкасаются на определенном расстоянии. Кромки мож-
но выбрать для создания эскизов, нанесения размеров и мно-
жества других операций. 
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Примеры работы с системой SolidWorks 2009 
 
Создание активного проекта детали 
Выберите в главном меню пункт Файл → Новый – по-

явится окно (рис. 4.3), в котором пользователь осуществляет 
выбор типа проекта. 

 

 
 

Рис. 4.3. Выбор типа проекта 
 
Выберите Деталь и нажмите снизу кнопку ОK. 
 
Особенности автоматизированного проектирования 

простых деталей в SolidWorks 2009 
Данные действия приведут к загрузке в рабочее простран-

ство чертежа дополнительных инструментов (CommandMan-
ager, Центр управления проектом, Вид, Стандартные ви-
ды, Кнопки ориентации вида) (рис. 4.4), посредством кото-
рых будет осуществляться проектирование детали. 
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Рис. 4.4. Рабочее пространство проектирования простой детали 
 
Основная функциональность (набор функций) инженерной 

идеологии проектирования SolidWorks 2009 представлена на 
панели закладок CommandManager.  

Закладка Элементы подсвечивает основные доступные в дан-
ный момент элементы, например, Вытянутая бобышка или 
Повернутая бобышка, для текущего проектирования трехмер-
ного объекта по составленному заранее двухмерному Эскизу.  

Проектирование новой детали начинается с закладки Эскиз, 
где пользователь моделирует основание (фундамент) последу-
ющей трехмерной модели с помощью плоскостных элементов 
(линий, окружностей, дуг, прямоугольников и т. д.). При этом 
необходимо в качестве основного выбрать Центр управления 
проектом → Дерево конструирования → Вид (рис. 4.5). Сле-
дует отметить, что в Дереве конструирования отображаются 
все созданные ранее объекты – части проектируемой детали  
с учетом их наследственных связей друг с другом, в то время 
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как изменение их свойств с возможным последующим их пе-
рестроением осуществляется в PropertyManager, вызываемом 
щелчком правой кнопки мыши (Редактировать Определе-
ние), на выбранном объекте в Дереве конструирования. 

 
 

 
 
 

Рис. 4.5. Выбор основного вида для проектирования эскиза  
моделируемой трехмерной детали 

 
 
Для перестроения любой составной части проектируемого 

объекта выберите его в Дереве Конструирования, вызовите 
PropertyManager, после чего нажмите кнопку Перестроить. 

Изменение вида при необходимости осуществляется кноп-
ками Ориентации либо кнопками панели Стандартные виды 
(рис. 4.6). 
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Рис. 4.6. Изменение вида кнопками ориентации модели в пространстве 
 

Задание к лабораторной работе 
 
С помощью подсказок в ресурсах интерактивной справки 

(пункт Создание моей первой детали) создайте модель детали 
Нажимная пластина ПИ-1 и затем чертеж модели данной де-
тали (рис. 4.7). При этом имейте в виду следующее:  

– для создания центрального отверстия выбирают элемент 
Отверстие под крепеж в CommandManager и указывают его 
свойства (отверстие под чистовой метчик M14×1.5). Затем ука-
зывают сначала произвольное расположение на верхней гра-
ни, а затем, определив координаты центра верхней грани про-
екции центральной осевой линии Нажимной пластины ПИ-1 
путем перестроения трехмерного эскиза, найдя проекцию (точ-
ку) центральной осевой линии Нажимной пластины и опреде-
лив ее пространственные координаты, изменяют координаты 
фронтальной проекции проектируемого отверстия под крепеж; 
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Рис. 4.7. Нажимная пластина ПИ-1 
 
– выбор подходящей глубины резьбы осуществляют кноп-

ками последовательного увеличения/уменьшения в зависимо-
сти от толщины Нажимной пластины (рис. 4.8); 

 

 
 

Рис. 4.8. Выбор подходящей глубины резьбового отверстия 
 
– создавая фронтальные разрезы (см. рис. 4.5), при указа-

нии «верхней» и «нижней» точек линии разреза необходимо 
следить за тем, чтобы курсор принимал вид . 
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Содержание отчета 
 
1. Титульный лист. 
2. Цель работы. 
3. Основные положения. 
4. Чертеж нажимной пластины. 
 
 

Лабораторная работа № 5 
 

ОСНОВНЫЕ ПРИЕМЫ МОДЕЛИРОВАНИЯ СБОРОК  
В СИСТЕМЕ SOLIDWORKS 2009 

 
Цель работы: освоить основные приемы трехмерного (3D) 

проектирования сборок на примере системы автоматизиро-
ванного проектирования SolidWorks 2009. 

 
Основные положения 

 
Сборка – это узел, состоящий из двух или более деталей, 

называемых компонентами, в одном документе SolidWorks. Рас-
положение и ориентация компонентов задается с помощью со-
пряжений, устанавливающих взаимосвязи между компонентами. 

Ограничения – объект (элемент) проекта, обозначающий 
добавления ограничений в геометрию модели. Взаимосвязь  
и размеры ограничивают степени свободы и геометрию дета-
лей, а сопряжения ограничивают компоненты в сборках путем 
добавления взаимосвязей. 

Взаимосвязи отображаются на эскизе. Существует несколь-
ко видов взаимосвязей: горизонтальность, вертикальность, 
зафиксированный, совпадение концентрический. 

Сопряжения – объекты проекта, вид и количество которых 
определяют геометрические условия существования сопряже-
ния деталей в сборке. 
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Примеры работы со сборками 
 
Выполнение тренировочного упражнения 
В меню Справка → Учебные пособия выберите пункт 

Упражнение 1 → Детали, и последовательно осуществите 
его выполнение. Затем выберите пункт Упражнение 2 → 
Сборки и Упражнение 3 → Чертежи. Также осуществите 
последовательное их выполнение. 

 
Проектирование «Корпус нажимной пластины» 
Разработайте конструкцию корпуса 1 (рис. 5.1) с учетом 

последующей вставки в него спроектированной ранее На-
жимной пластины 2. Сохраните деталь под именем Tutor1. 
При этом документ НЕ ЗАКРЫВАЙТЕ. 

 

 
 

Рис. 5.1. Проектируемая сборка 
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Вставка корпуса нажимной пластины 
В главном меню выберите пункт Открыть, после чего от-

кроется и сделается активным проект Нажимная пластина. 
Сохраните деталь под именем Tutor 2, оставляя документ от-
крытым. 

 
Создание сборки 
На закладке Сборка выберите Вставить компонент. Слева 

на закладке PropertyManager в списке открытие документа 
отобразятся имеющиеся открытые детали Tutor1 и Tutor2 для 
сборки. Разместите их поочередно в документе Сборка. 

Определите самостоятельно Условия сопряжения разме-
щенных деталей. 

Для того чтобы отобразить список имеющихся крепежных 
деталей в подключаемых библиотеках, при активном доку-
менте Сборка зайдите в главное меню Инструменты → До-
бавления. Выберите SolidWorksToolboxBrowser и SolidWorks-
Toolbox. В правой части чертежа выберите закладку библио-
теки проектирования разверните список Toolbox.  

 
Задание к лабораторной работе 

 
Самостоятельно подберите необходимый крепежный ин-

струмент и определите его параметры (диаметр стержня, дли-
ну, длину резьбы), исходя из вашего проекта. 

Для того чтобы поместить крепежный инструмент в место 
отверстия  на создаваемой сборке, необходимо, удерживая ле-
вую кнопку мыши, поднести выбранный крепежный элемент  
в зону пустого пространства отверстия. При этом произойдет 
его автоматическое перемещение, если у вас не будет ошибок 
в сопряжениях. 

В случае необходимости исправлений в Дереве конструи-
рования укажите необходимую деталь, нажмите на правую 
кнопку мыши и выберите пункт Редактировать деталь. При 
этом остальные детали на Сборке «скроются». 
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Содержание отчета 
 
1. Титульный лист. 
2. Цель работы. 
3. Основные положения. 
4. Чертеж с размерами разработанного корпуса 2 Нажим-

ной пластины. 
5. Сборочный чертеж всего проекта. 
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